ESP8266 WiFi

ESP8266 itself is a self-contained WiFi networking solution offering as a bridge from
existing micro controller to WiFi and is also capable of running self-contained applications.

This module comes with a built in USB connector and a rich assortment of pin-outs. With a
micro USB cable, you can connect NodeMCU devkit to your laptop and flash it without any
trouble, just like Arduino. It is also immediately breadboard friendly.
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1.

3.

Specification:

e Voltage:3.3V.

e Wi-Fi Direct (P2P), soft-AP.

e Current consumption: 10uA~170mA.

e Flash memory attachable: 16MB max (512K normal).
Integrated TCP/IP protocol stack.

Processor: Tensilica L106 32-bit.

Processor speed: 80~160MHz.

RAM: 32K + 80K.

GPIOs: 17 (multiplexed with other functions).
Analog to Digital: 1 input with 1024 step resolution.
+19.5dBm output power in 802.11b mode

802.11 support: b/g/n.

Maximum concurrent TCP connections: 5.

Pin Definition:

ADCO

!

RESERVED

RESERVED

GPIO10

GPIO14

SCLK GPIO12

RXD2

m
3.3v 6P1015 fed  TXD2 feoi
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HSPI/SPI

(2]
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w
E

SYSTEM

RST GPI01 ]—-[ TXDO

GND

a ¢ 2
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DO(GPIO16) can only be used as gpio read/write, no interrupt supported, no pwm/i2c/ow supported.

Using Arduino IDE
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The most basic way to use the ESP8266 module is to use serial commands, as the chip is basically a WiFi/Serial
transceiver. However, this is not convenient. What we recommend is using the very cool Arduino ESP8266 project,
which is a modified version of the Arduino IDE that you need to install on your computer. This makes it very
convenientto use the ESP8266 chip as we will be using the well-known Arduino IDE. Following the below step to
install ESP8266 library to work in Arduino IDE environment.

Install the Arduino IDE 1.6.4 or greater
Download Arduino IDE from Arduino.cc (1.6.4 or greater) - don't use 1.6.2 or lower version! You can use your
existing IDE if you have already installed it.

You can also try downloading the ready-to-go package from the ESP8266-Arduino project, if the proxy is giving you
problems.

Install the ESP8266 Board Package

Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional Board Manager URLs
field in the Arduino v1.6.4+ preferences.

.
Preferences &J

Settings | Network|

Sketchbook location:
C:Wsers\BY\Documents\ArdunnoI Browse |

Editor language: |System Default v | (requires restart of Arduino)
Editor font size: |18

Show verbose output during: [~| compilation || upload

Compiler warnings: .None -

[7] Display line numbers

[] Enable Code Folding

[7] Verify code after upload

[T] Use external editor

[7] Check for updates on startup

[V] Update sketch files to new extension on save (.pde -> .ino)

[7] Save when verifying or uploading

Additional Boards Manager URLs: | http://arduino.esp8266.com/stable/package_esp8266com_index.json @
More preferences can be edited directly in the file
C:\Users\BY \AppData\Local\Arduino 15\preferences. txt
(edit only when Arduino is not runnir
OK Cancel

Click ‘File’ -> ‘Preferences’ to access this panel.

Next, use the Board manager to install the ESP8266 package.

4] www.handsontec.com
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Scroll down to ‘ esp8266 by ESP8266 Community * and click “Install” button to install the ESP8266 library package.

@ Boards Manager

Type :AII v: !

More info

Arrow Boards by Axel Elettronica S.r.l.
Boards included in this package:
SmartEverything Fox, SmartTutto.
Cnline help

More info

EMORO 2560 by Inovatic-ICT

Boards included in this packaga:

EMoRo 2560. Board based on ATmega 2560 MCU.
Online help

More info

AMEL-Tech Boards by replaced by Arrow Boards
Boards included in this package:
SmartEverything Fox.

Cnline help

More info

aesp8266 by ESP8266 Community version 2.2.0 INSTALLED

Boards included in this package:

Generic ESPE266 Maodule, Olimex MOD-WIFI-ESPE266(-DEV), NodeMCU 0.9 (ESP-12 Module), NodeMCU 1.0 (ESP-12E Module), Adafruit
HUZZAH ESP8266 (ESP-12), ESPresso Lite 1.0, ESPresso Lite 2.0, SparkFun Thing, SweetPea ESP-210, WeMos D1, WeMos D1 mini, ESPino
(ESP-12 Module), ESPine (WROOM-02 Module), WifInfo, ESPDuinc.

Cnline help

More info

Select version - Install

Remove

m

Click ‘Tools’ -> ‘Board:’ -> ‘Board Manager...” to access this panel.

Once installation completed, close and re-open Arduino IDE for ESP8266 library to take effect.

Setup ESP8266 Support
Whenyou'verestarted Arduino IDE, select‘GenericESP8266 Module’ fromthe “Tools’->‘Board:’ dropdown menu.

i | Teols| Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Maonitor

Serial Plotter

Board: "Generic ESPE266 Module"
Flash Mode: "DIO"

Flash Frequency: "40MHz"

CPU Frequency: "80 MHz"

Flash Size: "512K (64K SPIFFS)"
Debug port: "Disabled”

Debug Level: "Mone”

Reset Method: "ck”

Upload Speed: "115200"

Port

Programmer "AVRISP mkIl"

Burn Bootloader

Ctrl+T

Ctrl+Shift+M
Ctrl+Shift+L

n once:
ry
Arduino Ethernet
Arduine Fio
Arduino BT

LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Pre Mini
Arduino NG or older
Arduino Robot Control
Arduine Robot Metor

Arduino Gemma

Select this

Arduino ARM (32-bits) Boards
Arduino Due (Pregramming Port)
Arduino Due (Mative USB Port)

ESP8266 Modules /
©  Generic ESP8266 Modul

Generic ESPE285 Module

Select 80 MHz as the CPU frequency (you can try 160 MHz overclock later)

5|
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— — e e S
Sketch (Tools| Help
- Auto Format Ctrl+T
Archive Sketch
-sep22 Fix Encoding & Reload
seti Serial Monitor Ctrl+Shift+M
+ + -
put Serial Plotter Ctrl+Shift+L |, nce: Select this
Board: "Generic ESP8266 Module” »
Flash Mode: "DIO" 4
Flash Frequency: "40MHz" 4 /
1o0] CPU Frequency: "80 MHz" l; © 80 MHz
put Flash Size: "512K (64K SPIFFS)" ii, }?f) MHz dly:

Debug port: "Disabled"
Debug Level: "None"
Reset Method: "ck"
Upload Speed: "115200"
Port

Programmer: "AVRISP mkIl"

Burn Bootloader

Select*115200’ baud upload speedisagood placetostart-lateronyou cantry higherspeedsbut 115200isagood

safe place tostart.

ETuaIs] Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

Board: "Generic ESP8266 Module”
Flash Mode: "DIO"

Flash Frequency: "40MHz"

CPU Frequency: "80 MHz"

Flash Size: "512K (4K SPIFFS)”
Debug port: "Disabled”

Debug Level: "None”

Reset Method: "ck”

Upload Speed: "115200"

Port

Prograrmmer: "AVRISP mkil"

Burn Bootloader

Ctrl+T

Ctrl+Shift+ M
Ctrl+Shift+L

n once:l

repeatedly:
Select this

@ 115200
9600
57600
256000
512000
921600

Gotoyour Windows ‘Device Manager’ to find out which Com Port ‘USB-Serial CH340’ is assigned to. Selectthe
matching COM/serial port for your CH340 USB-Serial interface.
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= Device Manager

File Action View Help
e | m|EH HE| % E %S
42 BY-PC

i M Computer

by Disk drives

..M Display adapters

> ¢4 DVD/CD-ROM drives
Uﬁ Human Interface Devices
b g IDE ATA/ATAPI controllers
b /¥ Jungo

= Keyboards

> - | Mach3 Pulseing Engine

b }f! Mice and other pointing devices

» M Monitors

¥ Network adapters

JF Ports (COM & LPT)

1? Communications Port (COM1)
T3 Printer Port (LPT1)

757 USB-SERIAL CH340 (COML1)

b 2 Processors

b % Sound, video and game controllers

b 1M System devices
- i Universal Serial Bus controllers
-4 WD Drive Management devices

‘Tools Help

Auto Format Ctrl+T
Archive Sketch
I Fix Encoding & Reload
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L
Board: "Generic ESP8266 Module” 4
Flash Mode: "DIO" 4
Flash Frequency: "40MHz" »
CPU Frequency: "80 MHz" »
Flash Size: "512K (64K SPIFFS)" 4
Debug port: "Disabled" »
Debug Level: "None" >
Reset Method: "ck” »
Upload Speed: "115200" 4
Port: "COMI11" ) Senal ports
Programmer: "AVRISP mkiI" ) o
v comil

Burn Bootloader

Find out which Com Port is assign for CH340

Selectthe correctCom Portasindicated on ‘Device Manager”

Note: if this is your first time using CH340 “USB-to-Serial ”interface, please install the driver first before proceed

the above Com Port setting. The CH340driver can be download from the below site:

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers

Blink Test

We'll begin with the simple blink test.

Enter this into the sketch window (and save since you'll have to). Connect a LED as shown in Figure3-1.

void setup() {
pinMode (5, OUTPUT) ;
}

void loop() {
digitalWrite (5,
delay (200) ;
digitalWrite (5,
delay (500);

}

// GPIOO05,

HIGH) ;

LOW) ;

Digital Pin D1

Nowyou'llneedto putthe boardinto bootload mode. You'll have to do this before each upload. Thereis notimeout

for bootload mode, so you don't have to rush!

e Hold down the ‘Flash’ button.

e While holding down ‘ Flash’, press the ‘RST’ button.

¢ Release ‘RST’, then release ‘Flash’

71
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e Whenyoureleasethe ‘RST button, the blue indication will blink once, this meansiits ready to bootload.

This blue indicator will
blink once when
release RTS in step 2.

Step 1: Hold
down this
‘Flash’ button.

Step 2: Press
once and
release this

‘/ button

Step 3: Release ‘Flash’ button. Now
the board is in ‘bootload’ mode.

Once the ESP board is in bootload mode, upload the sketch via the IDE, Figure 3-2.

vin R

05-90

Figure3-1: Connection diagram for the blinking test

FLASH3y3
=
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& blinky | Arduino 1.6,

File Edit Sketch Tools Help

Generic ESPS206 Module, 80 MHz. 40MHz, DIO, 115200, 512K (84K SPIFF

Figure 3.2: Uploading the sketch to ESP8266 NodeMCU module.

The sketch will start immediately - you'll see the LED blinking. Hooray!

Connecting via WiFi
OKonce you've got the LED blinking, let’s go straight to the fun part, connecting to a webserver. Create a new sketch
with this code:
Don’t forget to update:
constchar*ssid = "yourssid";
const char* password = "yourpassword";

toyour WiFiaccess pointand password, then upload the same way: getinto bootload mode, then upload code via
IDE.

/*
* Simple HTTP get webclient test
*/

#include <ESP8266WiFi.h>

const char* ssid
const char* password
password

"handson"; // key in your own SSID
"abcl234"; // key in your own WiFi access point

9| www.handsontec.com
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const char* host = "www.handsontec.com";

void setup() {
Serial.begin(115200);
delay(100) ;

// We start by connecting to a WiFi network

Serial.println();
Serial.println();

Serial.print ("Connecting to ");
Serial.println(ssid);

WiFi.begin(ssid, password);

while (WiFi.status() !'= WL CONNECTED) {
delay (500) ;
Serial.print(".");

}

Serial.println("");
Serial.println("WiFi connected");
Serial.println("IP address: ");
Serial.println(WiFi.localIP())

}
int value = 0;

void loop() {
delay(5000) ;
++value;

Serial.print ("connecting to ");
Serial.println (host);

// Use WiFiClient class to create TCP connections
WiFiClient client;
const int httpPort = 80;
if ('client.connect (host, httpPort)) {
Serial.println("connection failed");
return;

}

// We now create a URI for the request
String url = "/projects/index.html";
Serial.print ("Requesting URL: ") ;
Serial.println(url);

// This will send the request to the server
client.print (String("GET ") + url + " HTTP/1.1\r\n" +
"Host: " + host + "\r\n" +

"Connection: closel\r\n\r\n");
delay(500) ;

// Read all the lines of the reply from server and print them to Serial
while(client.available()) {

String line = client.readStringUntil('\r');

Serial.print(line);

}

Serial.println();
Serial.println("closing connection");

10 |
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Open up the IDE serial console at 115200 baud to see the connection and webpage printout!

@ Wifi | Arduino 167 -

oo ) )

File Edit Sketch Tools Help

har* ssid
har* password

ha www.hands

r* host =

a

ting to WiFi

& coMm11

connecting to www.handsontec.

HTTP/1.1 200 OK

Date: Sat, 24 Sep 2016 03:57:
Server: Apache

Last-Modified: Ssat,
Accept-Ranges: bytes
Content-Length: 260
Connection: close
Content-Type: text/html

Requesting URL: /projects/index.html

24 Sep 2016 03:44:33 GMT

Click here to Open Serial
Monitor

// key in your own SSID

// key in your own WiFi oint password

P

network

Generlo ESPB266 Module, 80 MHz, 40MHz, DIO, 115200, 512K (84K SPIFFS), ek, Disabled, None on COM11

com

m

01 GMT

ﬁg:;son Technology,

W

If you can read this message,

\SQEE:atulations £

Test Site for ESP8266 NodeMCU WiFi module,

you are successful conncted to your local WiFi Access Point

closing connection

Butoscroll

115200 baud v

v

That's it, pretty easy right ! This section is

just to get you started and test out your module.

11|
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4, Flashing NodeMCU Firmware on the ESP8266 using Windows

Why flashing your ESP8266 module with NodeMCU?

NodeMCU is a firmware that allows you to program the ESP8266 modules with LUA script. And you'll find it very
similartothewayyou programyour Arduino. Withjustafewlines of code you canestablishaWiFiconnection,
controlthe ESP8266 GPIOs, turning your ESP8266 into aweb server and a lot more.

In this tutorial we are going to use another ESP8266 module with pin header adapter board which is breadboard

friendly.

ESP8266 Module Breadboard Friendly with Header Connector

Parts Required:

e ESP8266 Module Breadboard Friendly
e PL2303HX USB-UART Converter Cable
¢ Some Male-to-Female JumperWires

Pin Assignment:

@ REesT
@ ~oc

® cHro
@ criote
@® cro14
@ cron2
@ crio13

@ vcc

[

|

™ @
R0 @
GPIO5 @
crios @
Grioo @
Grio2 @

Grio15 @

oo @

12
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Wiring:

[

PL2303HX USB-UART Cable

@ resT i v ™ ®
@ ~oc 1 g RO @ -
— @ CHPD | 1 GPIOs @
@ cros ! I cros @
@® cros : : GPIO0 (@
@ cro12 1 cro2 @
@ croo3 _ GrI015 @
@ vcc [N —
+3.3V
ESP8266 Pin Description
CH_PD Pull high, connect to Vcc +3.3V
Vce Power Supply +3.3V
TXD Connect to RXD (white) of PL2303HX USB-Serial converter cable
RXD Connectto TXD (Green) of PL2303HX USB-Serial converter cable
GPIOO Pull low, connect to GND pin
GND Power Supply ground

Downloading NodeMCU Flasher for Windows

After wiring your circuit, you have to download the NodeMCU flasher. This is a .exe file that you can download using

one of the following links:

Win32 Windows Flasher
Win64 Windows Flasher

You can find all the information about NodeMCU flasher here.

Flashing your ESP8266 using Windows

Open the flasher that you just downloaded and a window should appear (as shown in the following figure).

Q adafruit-io-basics-master.zip
Q eclipse-cpp-mars-R-win
W' ESP8266Flasher.exe
Q ESPlorer.zip

U Espressif-ESP8266-DevKit-v2.1.0-x86.exe
g V3.1_win32.2016-08-03_16-31-05.tar.gz

Double click to run
this program once
installed in your

. AR ZIP

hard disk folder i
AR LIV

12/24/2016 5:12PM  Application
12/24/2016 2224 PM  WinRAR ZIP

9/14/2016 7:44 AM Application
9/12/2016 11:06 AM  WinRAR arch

13|
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E.
Operation Config Advanced About Log

COM Port COM26 Flash(F)

AP MAC Waiting MAC

STA MAC Waiting MAC

NODEMCU TEAM Ready

Pressthe button“Flash” and it should start the flashing process immediately, showing the Module MAC addressiif
successful connected.

E.
Operation Config Advanced About Log

COM Port COM26 Stop(S)

E.
Operation Config Advanced About Log

COM Port COM26 Flash(E)

AP MAC A2-20-A6-0F-2A-CO

STA MAC A0-20-A6-0F-2A-CO

Q NODEMCU TEAM Ready

Your ESP8266 module is now loaded with NodeMCU firmware.

www.handsontec.com
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5. Getting Started with the ESPlorer IDE

ESPlorer is an IDE (Integrated Development Environment) for ESP8266 devices. It’s a multi platform IDE, can be
used in any OS environment, this simply means that it runs on Windows, Mac OS X or Linux.

Supported platforms:

o Windows(x86, x86-64)

e Linux(x86, x86-64, ARM soft & hard float)
e Solaris(x86, x86-64)

o Mac OS X(x86, x86-64, PPC, PPC64)

This software allows you to establish a serial communications with your ESP8266 module, send commands, and
upload code and much more.

Requirements:

¢ You needto have JAVA installed in your computer. If you don’t have, go to this
website: http://java.com/download, download and install the latest version. Itrequires JAVA (SE version 7
and above)installed.

¢ Inorderto complete the sample project presented in this Guide you need to flash your ESP8266 with
NodeMCU firmware. Referto chapter-4 in this guide on howto flashthe NodeMCU firmware.

Main Resources:

o ESPlorer Homepage: http://esp8266.ru/esplorer/
e GitHub Repository: https://github.com/4refrOnt/ESPlorer

Installing ESPlorer

Now let’'s download the ESPlorer IDE, visit the following URL.: http://esp8266.ru/esplorer/#download

Grab the folder that you just downloaded. It should be named “ESPlorer.zip” and unzip it. Inside that folder you
should see the following files:

Name Date modified Type Size

_lua 8/15/201612:27 PM  File folder

_micropython 8/15/201612:27 PM  File folder

lib 8/15/2016 12:26 PM  File folder
(55 ESPlorer.bat 12/16/2014 4:49 AM  Windows Batch File 1KB
|| ESPlorer.jar 4/30/2016 11:28 PM  Executable Jar File 2,330 KB
|_| ESPlorer.Log 3/5/2017 6:11 PM Text Document 4 KB
|| ESPlorer.Log.l 3/5/2017 1:37 PM 1 File 4 KB
| version.txt 8/15/201612:26 PM  Text Document 1 KB

Execute the “ESPlorer.jar” file and the ESPlorer IDE should open after a few seconds (the “ESPlorer.jar” file is what
you need to open every time you want to work with the ESPlorer IDE).

15| www.handsontec.com
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Note: If you're on Mac OS X or Linux you simply use this command line in
java —jar ESPlorer.jar.

When the ESPlorer first opens, that’s what you should see:

your terminal to runthe ESPlorer: sudo

i ESPlorer v0.2.0-rc5 by Arefrint E=Te %]

File Edit ESP View Links?

New

[NbdéMcU&Mi&bemdn'] AT-based | RN2483 ‘V;tcomze _ﬂ
_[ Scripts TCommandsTSnippetsT Settingsf’-‘] & ] S [ Atascran c] VLJ e Eamor
o B & B B B 9 ¢ & [ o OB | o | U= W e
'~ Open Reload Save Save.. Closs = Undo Redo ~ Cut  Copy ‘} D;;R ’ Rt-?g l%o” 'J [ —— |

[1[ & Format E
| |[ EJFsinfo

S Reload

A

S oc

|3l SaveBRun J [ SaveRCompile J { Save&Compile&Run... J L
i | saveacompie Al J [ View on ESP J | View on ESP J Il _ ‘ i ‘
‘ L | Hew J [ Chip Info J [ Chip ID J [ FashiD |
! B SavetoESP B sendtoEse @ run @ e

Here’s a rundown of the features the ESPlorer IDE includes:

e Syntax highlighting LUA and Python code.

o Code editor color themes: default, dark, Eclipse, IDEA, Visual Studio.

e Undo/Redo editors features.

e Code Autocomplete (Ctrl+Space).

e Smart send data to ESP8266 (without dumb send with fixed line delay), check correct answer from ESP8266
after every lines.

e Code snippets.

e Detailed logging.

e Anda lot more...

The ESPlorer IDE has a couple of main sections, let’s break it down each one.

In the top left corner you can see all the regular options that you find in any s
file, Save file, Save file as, Undo, Redo, etc.

W ESPlorer v0.2.0-rc5 by 4refrOnt

oftware. Create a New file, Open a new

File Edit ESP View Links?

[ NodelCU & MicroPython | AT-based | RN2483 |

J Scripts T Commands T Snippets T Seﬁingsﬁ]

O & &6 B R E 5 ¢

Open  Relboad Save Save.. Close Undo Redo

Cut  Copy Paste

Mew

16
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In the top right corner you have all the options you need to establish a serial communication (you’re going to learn
how to use them later in this Guide).

‘| com2s |
(=) =) sl || AdteScral o= [ roe Eamor
Open CT: @, ~ []eo =[] rce Termmat
g Open ==
e b 9600 = | Donate
DTR { RTS [

This next screenshot shows your Code Window, that’s where you write your scripts (your scripts are highlighted with
your code syntax).

Below the Code Window, you have 12 buttons that offer you all the functions you could possible need to interact with
your ESP8266. Here’s the ones you’ll use most: “Save to ESP” and “Send to ESP”.

l SaveRRun J [ SaveBCompis J [ SaveRCompileBRun.., J l Save As init J
l SaveBCompie Al J [ View on ESP J [ View on ESP J l SaveBCompile J
B Saveto ESP E¥ Sendio ESP Run @ Upload ...

This screenshot shows the Output Window which tells you exactly what’s going on in your ESP8266. You can see
errors and use prints in your code to debug your projects.

Al [ Format
[EJFsinfo
[ S Reload

[ Hezp “ Chip Info H Chip ID H Flash 1D J @ ===
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Schematics

To upload code to your ESP8266, you should connect your ESP8266 to your PL2303HX USB-UART Programming Cable

like the figure below:

@ rResT
® ~oc
@® ciro

@ criots
® croi4
@ crior2
@ croms

® vcc

+3.3V

Writing Your Lua Script

Below is your script to blink an LED.

[

™ @

RXD
GPIO5 @
GrIos @
GrIo0 @
cri02 @

|

GPIO15
GND

PL2303HX USB-UART Cable

end)

lighton=0

pin=4

gpio.mode (pin, gpio.OUTPUT)

tmr.alarm(1,2000,1, function ()
if lighton==0 then

lighton=1

gpio.write (pin,gpio.HIGH)
else

lighton=0

gpio.write (pin, gpio.LOW)
end

init.lua

gpio.write(pin,gpio.HIGH)

L=
lighton=@

rite(pin,gpio.LOW)

Right now you don’t need to worry how this code works, but how you can upload it to your ESP8266.
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Having your ESP8266+PL2303HX Programmer connected to your computer, go to the ESPlorer IDE:

Flle Edit ESP View L|nk 2

[ NodeCU & MicroPython | I AT-based I RN2483 ] [[comzs 2|
_[ Scripts T Commands T Snippets T Settlngsg/- ] @ @ : [ Adtoscran ca [ roeeonor
0 B & B B m % €& & [ (RO Sl S
- Reload Save Save.. Closs Undo Redo Cut
— = 25 DTR l RTS ‘9600 ‘vl Donate }

4| /[ G Format E
| | EJFsinfo
|l ‘G Reload

l Hesp Jl Chip Info Jl Chip ID J[ Flash ID J ® ===

Look at the top right corner of your ESPlorer IDE and follow these instructions:

Ao bdPE

Press the Refreshbutton.
Select the COM port for your FTDI programmer.
Select your baudrate.

Click Open.
ESPlorer v0.2.0-rc2 by 4refrOnt - 6§
= }——Step 2 -Sefect COM%@_ T
|| opon o7 I.“_ e Step 1 - Refresh
® = T
ek _the | OTR | | RTs ‘ 3608 ﬂ b Step 3 - baudrate
A ‘\ s Formal |
| ElFs o |
‘ ‘G Reload

Step 4 - Click open

Then in the top left corner of your ESPIlorer IDE, follow these instructions:

1.
2.
3.

Select NodeMCU
Select Scripts
Create a new filled called “init.lua”
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»

File Edit ESP View Links ?

NedsHoU sMicroRython im0 ConisnctisntCtey 1 - Select NodeMCU

- Commands | Snippsts | Setings
o B & 5 B 59 T—Step 2 - Select Script

Opzn Reboed  Save Sawen. ooz | Undo  Rzdo

initlua
ligh =
pryib i Step 3 - Create a hew

io.mode(pin, gpio. OUTPUT . PR
e S metaon() filed called init.lua
if lighten=-2 then
lighton=1
gpic.write(pin,gpio.HIGH)
else
lightan=8
gpic.write(pin,gpio.LOW)
end

ra

o
L= - T = Ty I SO )

12 endd

Copy your Lua script to the code window (as you can see in the Figure below):

®

Fila Edit ESF View Links ?

[ HoaeMGUMieroRytnon | AT vo 20 | Frankensntain |

[ senpte | commanas | snippets | setings.* |

B & H B B % ¢ 4

T
- Opan Reioed  Saue  Save.. Closs Undes  Redo Cut  Oopy Pasle

lighton=2
2 Fin:d-
goio.mode(pin,gpio, OUTPUT |

4 | tmr.alarm(1,2888,1,function()
5 if lighton==8 then

i lightan=1

7 gpilo.write(pin,pgpio.HIGH)

3 else Step 1 - Copy

q lighton=8 . [

10 griowrite(pingpio.Lowy | YOUr code to this window
11 end

12 |end]

The next step is to save your code to your ESP8266!

At the left bottom corner click the button “Save to ESP”.

In your output window, it should start showing exactly which commands are being sent to your ESP8266 and it should

look similar to the Figure below.
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Note: If you want to delete your “init.lua” file, you can do that easily. Simply type file.remove(“init.lua”) and press
the button “Send” (see Figure above). Or you can type the command file.format() to remove all the files saved in your

L]

Fie Edll ESF Wiew Lnks 7

ESPlorer w0.2.0-rc2 by drefrDnt

| ‘HodeCLU Ko oPrian I ATwl2D | Frankenzhbein

_| Bpes | commarwds | snippets | Setings.” |

E # H B 3 ¢ 4 B O
Unda Mede  Tet  Topy Faslm Boc

lighten=i

prr=

polo. mode pin, gpio. OUTRUT )

. alarm 1, 2ead, 1, functiond |
I¥ lighton==8 then

L]
Lm

w = file,writeline

w{[[lighton=0]]);

{[[pin=a]]);
{[[gpio.node{pin, gpio. OUTPUT}]]);
[[[tor.alarn{l, 2008 1, function(}]]);

if lighton==8 than]]};
lighton=171);

1ightan=l
gpio.writel pin.gpio. HIGH)
1].:!!11!:'_rt GI.ITFI ut
cn=i
y gpia. wrikn] pin, gpia. L) Window
[

... wred
' Click Save to ESP to
upload your init.lua script

You can remove your init.lua, if you type:
file.remove("init.lua") and click "Send"

else]]ll;
lighton=8]11};
gpio.write{pin,gpio.LOW)
end]]);
w([[erd)]]d;
file.closal);
dofile(™init, Lua™);

W
L]
W
W
W
L]
L]
W
W
L]

[l
[l
[ gplo.writelpin,gpio. HIGH)
[l
[l
[l
[l

& oL | \
[ Seeelifin ]| SaveACorzis ||m..]| Zuren A8 |
| swescfuwis || vewseE || vewanes || Seecome
I'-_.iﬂwatnEBF 'Iﬁamuhesr-“-ﬂnﬁn || G upess_.

\ | e || meppena | | seppsiz
[t |

I Tlo.mmossItiuaT)

Chip l hip 1T J| Ranil |

[ | R

| Do

ESP8266. You can type any commands and send them to your ESP8266 through that window.

After uploading your code to your ESP8266, unplug your ESP8266 from your computer and power up the ESP8288

module.

Blue LED will start
blinking.

Congratulations, you’ve made it! The blue LED at the upper right corner should be blinking every 2 seconds!
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6. NodeMCU GPIO for Lua

The GPIO(General Purpose Input/Output) allows us to access to pins of ESP8266 , all the pins of ESP8266 accessed
using the command GPIO, all the access is based on the I/O index number on the NoddMCU dev kits, not the internal
GPIO pin, for example, the pin ‘D7’ on the NodeMCU dev kit is mapped to the internal GPIO pin 13, if you want to
turn ‘High’ or ‘Low’ that particular pin you need to called the pin number ‘7°, not the internal GPIO of the pin. When
you are programming with generic ESP8266 this confusion will arise which pin needs to be called during
programming, if you are using NodeMCU devkit, it has come prepared for working with Lua interpreter which can
easily program by looking the pin names associated on the Lua board. If you are using generic ESP8266 device or any
other vendor boards please refer to the table below to know which 10 index is associated to the internal GPIO of
ESP8266.

Nodemcu ESP8266 Pin Nodemcu dev | ESP8266 Pin

dev kit kit
DO GPI1O16 D7 GPI10O13
D1 GPIO5 D8 GPI1015
D2 GP104 D9 GPI103
D3 GPI100 D10 GPIO1
D4 GPI102 D11 GPI109
D5 GPI1014 D12 GPI010
D6 GPI1012

DO or GPI0O16 can be used only as a read and write pin, no other options like PWM/I2C are supported by
this pin.

In our example in chapter 5 on blinking the blue LED, the blue LED in connected to GPIO2, it is defined as
Pin4 (D4) in Lua script.

7. Web Resources:

e ESP8266 Lua Nodemcu WIFI Module

e ESP8266 Breadboard FriendlyModule
e ESP8266 Remote Serial WIFI Module

e PL2303HX USB-UART Converter Cable
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